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THE BENEFITS OF EXCEL



, ' Why Use Excel?

Excel spreadsheets allow additional analytical
capability without requiring your software
vendor to program a specific analysis for you.

Excel can be an easy way to review significant
amounts of data to identify particular issues or
situations.

Excel can be used to check calculations
performed within your CAMA system to verify
accuracy.



,' Why Use Excel?

e Excel provides a generally universal method for
sharing data and information with others.

e Excel can be used to prepare custom handouts
and reports to highlight particular findings.



¥ Microsoft Excel

e Common versions:
—  Excel 2007
— Excel 2003

e While this discussion will focus on Microsoft
Excel, some of the capabilities discussed in this
class would also be present in other spreadsheet
packages. Typically, the Help option can be used
to find particular functionality.



BACK TO BASICS



B Spreadsheet — Table used to store and display
data. The table is arranged by rows and
columns.

e Worksheet — Single page or tab within the Excel
workbook.

e Workbook — The entire spreadsheet file.



Terminology
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3 Terminology

e Row — Horizontal array of data.
— Signified by numbers — Row 1, Row 2, etc.

—  Maximum number of rows:
e Excel 2003 - 65,536
e Excel 2007 —-1,048,576

e Column —Vertical array of data.

— Signified by letters — Column A, column B, etc.

—  Maximum number of columns:
e Excel 2003 — 256
e Excel 2007 — 16,384
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e Cell = Individual cell. Intersection of a row and a
column.

— Signified by a combination of the column letter and
the row number.

e Examples: A1, C300, BA42
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Terminology
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o Office Button

e Home Menu

e |nsert Menu

e Page Layout Menu

e Formula Menu

e Data Menu

e \View Menu
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"} Office Button
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Home Menu
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e Formatting

e Type of Number
— S, %, Decimal Points

e Conditional Formatting
e Sort and Filter
e Find and Select
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Insert Menu

./:-.\“' = s Bookl - Microsoft Excel -8gX
| =
- Home Insert Page Layout Formulas Data Review View Developer Acrobat @ - @ X
=] HE ) = oy ‘) A :'] ' ,a" :] Q
|JJ | T | "|__‘_|') lﬁ m %{ ‘ ='" & s a e | = o ?ﬁ
PivotTable Table Picture Clip Shapes Smart&rt || Column Line Pie Bar Area  Scatter Other Hyperlink Text  Header WordArt Signature Object Symbol
- A id ni 7 = = v b Charts ~ Box & Footer 2 Line =
Tables Mlustrations Charts £l Links Text
Al * ke |
A B c D E E G H | J K L M N (0] P

2
=]
]

PivotTable

16



Page Layout Menu
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Formulas Menu
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Data Menu
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View Menu
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e (Can Search for help or use the Table of Contents

e Another good resource is the Internet
e Example: Go to Google and type in what you are
trying to accomplish
e “How tosortin Excel”

e Access various user forums and questions and
answers
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HANDS-ON EXERCISES
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» Sample Data

e |n order to complete these hands-on exercises,
yvou will need the Land.xls and OILGAS.txt files
installed on your computer.

e These files contain sample data from actual Land
and OILGAS files submitted to the State for
review.

e While we are using these files in our examples,
the functionality discussed could be used with
other files created by you or generated by your
CAMA system.
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i1 Freeze Panes

e |ocated on View Menu

e Freeze Top Row so Column Headings are always
available

— Ensure Column Headings are the top row of your
spreadsheet

— Go to View Menu
— Select Freeze Panes
— Select Freeze Top Row
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Insert Column between Depth Factor and
Acreage Factor

— Select Acreage Factor column

— Right Click to access menu

— Select Insert
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Ctrl — F or on Home Menu (Binoculars)
Find Land ID Number 149254738

—  Press Ctrl-F or press the Find button on the Home Menu
—  Type 149254738 in the Find What box
— Select Find Next or hit Enter
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Located in same place as Find

e Ctrl — F or on Home Menu (Binoculars)
Replace Year 2010 with Year 2011

Select Year column

Press Ctrl-F or press the Find button on the Home
Menu

Go to second tab

Type 2010 in the Find What box
Type 2011 in the Replace With Box
Select Replace or Replace All
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"o Available on Home Menu and on Data Menu
e Sort by Land Lot Type Code

— Select full data range
— Select Custom Sort

— Select LAND _LOT _TYPE_CODE in the Sort by
dropdown box

e |f not seeing this as an option, you may need to check
the box next to “My data has headers” to exempt the
first row from the sort

— Select order in which you would like it sorted
— Hit OK
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o Available on Home Menu and on Data Menu in
same place as Sort

e Filter for Land Tot Type Code 91

Select Row 1

Go to Sort & Filter on Home Menu or to Filter on
Data Menu

Select Filter

Go to drop down arrow on Land Lot Type Code
Header

Uncheck all Land Lot Type Codes other than 91
Hit OK
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Availab
same p

Clear fi

% Clear Filter

e on Home Menu and on Data Menu in
ace as Sort and Filter

ter from Land Lot Type Code column

1. Go back to drop down box on top row of Land Lot

Type Code
a) Select All
b) Clear Filter

Clear

2. On Home Menu and Data Menu, option available for
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‘! Conditional Formatting

e Available on Home Menu

e Next few screens walk through pre-defined
options

e You can also get more specific through New Rule
or Manage Rule options
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Conditional Formatting
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Conditional Formatting
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‘! Conditional Formatting

e Highlight Duplicate Values in the Land ID Column
— Select the Land ID Column
— Go to Conditional Formatting
— Select Highlight Cell Rules
— Select Duplicate Values...

— Can customize format of the rule
— Hit OK

e To clear Conditional Formatting
— Go to Conditional Formatting
— Select Clear Rules

— Select Clear Rules from Selected Cells or Clear Rules from
Entire Sheet as applicable
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® Remove Duplicates

Located on Data Menu

Remove Duplicate Records
— Select full data range
— Select Remove Duplicates

— Select which columns contain duplicates

e To ensure the full record is an exact duplicate, select
all columns

— Hit OK
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" Functions

e Excel has a large number of built in functions.

e To use these pre-defined functions, you need to
be cognizant of the specifics of the function:
— What is the function designed to do
— What cells need to be included in the calculation
— What criteria must you specify for the calculation

— In what order are these cells or criteria required to
be entered

e Formula Dictionary on Formulas Menu
— Insert Function
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588 Functions

Common Functions

SUM — Adds together selected values

MIN — Identifies the minimum value in selected range
MAX — Identifies the maximum value in selected range
AVERAGE — Calculates the average of selected values

ROUND — Rounds numbers to a particular decimal point
precision

COUNT — Counts number of values in selected range

IF — Checks for the existence of the specified condition

and returns different values if the condition is true or
false

SUMIF — Adds values together if they meet a certain
condition
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3 Functions

| Sum Appraised Value for all records

Go to bottom of the Appraised Value column
In cell below data, type =SUM(

Specify range to be included in calculation
Close formula with an end parenthesis

Hit Enter

=SUM(L2:L202)

ldentify Minimum Value for Base Rate

Go to bottom of the Base Rate column

In cell below data, type =MIN(

Specify range to be included in calculation
Close formula with an end parenthesis

Hit Enter

=MIN(K2:K202)
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#F38 Functions

ldentify Maximum Value for Acreage
— Go to bottom of the Acreage column
— In cell below data, type =MAX(

— Specify range to be included in calculation
— Close formula with an end parenthesis

— Hit Enter

— =MAX(M2:M202)

Determine Average of Square Footage
— Go to bottom of the Square Footage column
— In cell below data, type =AVERAGE(

— Specify range to be included in calculation
— Close formula with an end parenthesis

— Hit Enter

~  =AVERAGE(N2:N202)
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2 Functions

ROUND
— Go to cell right below Average calculation
— Type =ROUND(
— Select cell to be rounded
— Inserta comma

— ldentify decimal point precision
e (0=nodecimals

e 2 =two decimals

e -2 =roundto nearest 100

— Close formula with an end parenthesis
— Hit Enter
— =ROUND(N204,0)
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8 Functions

e Count the number of records with a Soil
Productivity Factor
— Go to bottom of the Soil Productivity column
— In cell below data, type =COUNT(
— Specify range to be included in calculation
— Close formula with an end parenthesis
— Hit Enter
— =COUNT(P2:P202)
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Functions

ldentify records with acreage greater than 1

Go to empty column — Column Z
Type =IF(

Define criteria

e Acreage greater than 1

Insert comma

Insert value if true

Insert comma

Insert value if false

Close formula with an end parenthesis
Hit Enter

Drag or fill down formula down cell
=IF(M2>1,TRUE,FALSE)
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Functions

e Sum appraised value if the acreage is greater than 1

— Select an empty cell next to Column Z

—  Type =SUMIF(

— Define range to be included in calculation
e ColumnZz

— Insert comma

— Insert criteria
e “TRUE”

— |nsert comma

— Insert value to be summed
e Appraised Value
— Close with end parenthesis
— Hit Enter
—  =SUMIF(Z2:2202,"TRUE",L2:L202) ”



3 Functions

e Sum appraised value if the acreage is greater than 1

— Select an empty cell next to Column Z

—  Type =SUMIF(

— Define range to be included in calculation
e ColumnZz

— Insert comma

— Insert criteria
e “TRUFE”
— |Insert comma

— Insert value to be summed
e Appraised Value

— Close with end parenthesis

— Hit Enter

— =SUMIF(Z2:2202,"TRUE",L2:L202)
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b  Su btotal

e |ocated on Data Menu

e Subtotal Appraised Value and Acreage by Parcel
Number

Select full data range
Select Subtotal button on Data Menu

Select PARCEL NUMBER in drop down box for At Each
Change In

Use Function SUM

Check Appraised Value and Acreage as columns to
add subtotals to

Hit OK s



)X Remove Subtotals

Located on Data Menu

Remove Subtotals

Select full data range

Select Subtotal button on Data Menu
Hit Remove All
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Excel provides a wide range of charting options

on the Insert Menu.
— Column Charts

— Pie Charts
— Bar Charts
— Line Charts
nulas Data Review View Developer
gl 1 @ = dy LD
Column  Line Pie Bar Area Scatter Other
- - - - - - Chartﬂ'r

Charts F
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 Charts

e Design a column chart showing acreage by Land
Lot Type

— Create chart data

e Copy (right click or Ctrl-C) Land Lot Type Code column and
paste (right click or Ctrl-V) to Sheet 2

e Remove duplicates (Data Menu)

e C(Create SUMIF statements to add acreage by Land Lot Type
Code

—  Can use permanent call references to create one formula and drag
down

— SorF4

—  Determine what needs to be permanent in the formula

—  =SUMIF(Sheet1!5GS2:5GS202,Sheet2!SA2,Sheet1!SMS2:5MS$202)
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. Design a column chart showing acreage by Land
Lot Type (continued)

— Add Acreage heading on Sheet 2
— Select chart data on Sheet 2

— Go to Insert Menu

— Select Column Chart — 2-D Column

— Can use Design, Layout and Format menus specific to
the Chart to change how the Chart is presented

e Add Acreage totals to top of columns

— Update chart title in chart directly
e Acreage by Land Lot Type
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Printing

Before printing

— Determine the purpose for your printing and try to
arrange your data so you get the exact printout you
need.

— Print preview before printing to ensure the final
printout will be useable.
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Printing

e Print Preview

— Customize size and layout of paper
— Center on page

— Add headers and footers
e Title of worksheet
e Page numbers
e Prepared by
e Any disclaimers or notes

e Page Layout Menu — Print Titles

— Customize column or row headings to be repeated on
each page during printing
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Import Text File Into Excel

Open a blank excel spreadsheet. Click the Office
Button.

Click on OPEN (or use the icon button)

Navigate to where you saved the .txt file and
open it.

Highlight the filename you want to open and click
OPEN.

A TEXT IMPORT WIZARD box will open prompting
you to select how you want the data to appear
when viewed using excel.
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.........
o

i Import Text File Into Excel

e The Wizard allows you to manage the break lines
between your data.

e The Wizard allows you to choose column formats,
provides data preview, and other advanced

settings. When everything is organized, click on
Finish.
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.........
o

¥ Pivot Table

e Open your original spreadsheet and remove any
blank rows or columns.

e Make sure each column has a heading, as it will
be carried over to the Field List.

e Make sure your cells are properly formatted for
their data type.

e Highlight your data range.
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Pivot Table

X p.

% ey phe 2
phhest - et
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Click the Insert tab.

Select the PivotTable button from the Tables
group.

Select PivotTable from the list.

Double-check your Table/Range.

Select the radio button for New Worksheet.

Click OK.
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Vlookup Function

e The syntax for the VLOOKUP function is:

= VLOOKUP ( lookup value, table array, col index num , range lookup )

lookup _value: The value you want to find in the first
column of the table array.

table_array: This is the table of data that VLOOKUP
searches to find the information you are after.

The table array must contain at least two columns of
data. The first column contains the lookup_values.

col_index_num: The number of the column in the
table_array that contains the data you want
returned. 56



@ 3% Contact the Department

e Eric Bussis, Director of Data Analysis
e Telephone: 317.232.3759
e Fax:317.232.8779
e E-mail: ebussis@dlgf.in.gov

e Web site: www.in.gov/dlgf

e “Contact Us”:
www.in.gov/dlgf/2338.htm.
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